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1 ANTECEDENTS 

1.1 INTRODUCCIÓ 

L’Institut Català del Sòl va signar un conveni amb el Centre de Política del Sòl i 

Valoracions de la Universitat Politècnica de Catalunya per a realitzar un prototipus de 

Sistema d’Informació Territorial que catalogués el seu patrimoni. 

Aquest projecte forma part del Màster en Sistemes d’Informació Geogràfica que 

imparteix la Fundació Politècnica de Catalunya (FPC) i recull part de la tasca realitzada 

dins del CPSV per a aquesta institució. 

1.2 OBJECTIUS DEL PROJECTE 

L’objectiu del prototipus és obtenir una eina en forma de prototipus capaç de satisfer 

les necessitats que té INCASOL de gestionar el seu patrimoni. 

Aquesta gestió del patrimoni no es tracta únicament d’un inventari de propietats sinó 

que necessita incorporar una sèrie de funcionalitats addicionals, degut a algunes 

característiques específiques de INCASOL comunes a qualsevol entitat que gestioni una 

gran quantitat de sòl. 

- Cal fer el seguiment del planejament que afecta aquest sòl o que pot afectar les 

futures adquisicions de sòl. 

- És necessari mantenir un registre històric de les adquisicions, les cessions i les 

vendes per a fer un seguiment de la evolució de les entitats patrimonials i en 

qualsevol moment poder saber la procedència de cada unitat de patrimoni. 

- De la mateixa manera cal saber quin contingut té cada unitat de sòl (des del 

nombre d’arbres fins l’edifici que hi ha edificat). 

- Degut a la naturalesa canviant del conjunt del patrimoni, es necessita generar 

sortides (en forma de mapes i llistats) que tinguin la informació permanentment 

actualitzada. 

- Cal determinar amb facilitat la interacció del planejament amb el sòl del qual és 

propietari i poder fer projeccions amb hipòtesis (recordem que INCASOL pot ser 

Administració Actuant). 

- Cal poder superposar informació provinent d’altres organismes o d’altres 

departaments de INCASOL amb facilitat i precisió. 
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És necessari donar resposta a aquestes necessitats amb un sistema robust i 

suficientment obert per a tenir la capacitat d’acomodar nova funcionalitat en el 

moment que esdevingui necessària. 

1.3 OBJECTIUS D’AQUEST PROJECTE 

Els  objectius són múltiples donada la complexitat i l'extensió dels treballs: 

- Desenvolupar una metodologia que permeti vincular de manera automàtica la 

interacció entre la informació de planejament i les finques propietat de INCASOL. 

- Investigar altres solucions que s’hagin aplicat a casos semblants. 

- Aprofundir en el coneixement de la legislació en matèria de sòl i urbanisme. 

- Conèixer la tasca que realitza l’Institut Català del Sòl, fer un anàlisi de la 

informació disponible i sintetitzar-ne uns camps que la descriguin. 

- Posar en pràctica l’ús de les eines informàtiques de GIS, en especial les eines de 

programació. 
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2 CONTEXT 

2.1 MARC LEGISLATIU 

INCASOL té competències per a actuar en el territori de la Comunitat Autònoma de 

Catalunya; per tant en matèria d’urbanisme la legislació aplicable serà únicament la 

corresponent a Catalunya en virtut de la sentència del Tribunal Constitucional 

61/1997, de 20 de març. En matèria de sòl ens remetrem a la legislació espanyola. 

Tot això sense perjudici de la legislació o normativa de nivell europeu que sigui 

d’aplicació, per exemple en el cas de matèria mediambiental. 

 
Figura 1: Esquema de nivells de planejament del territori 

El sistema recull els conceptes continguts en la següent legislació: 

- Text refós de la llei d’urbanisme (en endavant LUC) 

Decret legislatiu 1/2005, de 26 de juliol, pel qual s’aprova el text refós de la llei 

d’urbanisme 

- Reglament de la llei d’urbanisme (en endavant RLUC) 

Decret 305/2006, de 18 de juliol, pel qual s’aprova el reglament de la llei 

d’urbanisme 

- Llei de sòl (en endavant LS) 

Llei 8/2007, de 8 de maig, de sòl 

- Mesures urgents en matèria urbanística 

Decret-llei 1/2007, de 16 d’octubre, de mesures urgents en matèria urbanística 
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- Llei del dret a l’habitatge 

Llei 18/2007, de 28 de desembre, del dret a l’habitatge 

Per altra banda, també es tenen en compte els conceptes que apareixen en els 

documents de Sistematització del Planejament Urbanístic en procés d’elaboració per 

part del DPTOP de la Generalitat de Catalunya. 

2.2 TECNOLOGIA SIG 

Com el seu nom indica, la tecnologia dels Sistemes d’Informació Geogràfica aporta un 

component addicional als Sistemes d’Informació: el component geogràfic. 

Aquesta aportació no és trivial doncs el component geogràfic permet relacionar dades 

que d’altra manera seria impossible de relacionar. En aquest sentit, la localització 

(posició i geometria) actua com un “super-camp”. 

Un GIS presenta un gran avantatge sobre altres sistemes d'informació per a 

organitzacions que treballin sobre el territori; les dades acostumen a ser molt 

disperses però gairebé sempre tenen un component geogràfic. Aquest component 

geogràfic pot convertir-se en vertebrador dels continguts i millorar la comunicació 

entre departaments. 

2.2.1 AVANTATGES DEL SIG 

Aquestes virtuts son especialment importants en institucions que tracten amb el 

territori com INCASOL: 

1) Permet superposar i relacionar informació de molt diferents procedències, entre 

d’altres: 

- Ortofotos 

- Topografia 

- Planejament 

- Plànols històrics 

- Dades estadístiques 

2) Permet establir relacions entre les entitats en funció de la seva geometria, com 

per exemple: 

- Inclusió 
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- Intersecció 

- Proximitat 

3) Permet operar amb aquestes geometries, per exemple: 

- Saber quin percentatge d’una finca esta dins d’un municipi 

- Comptar el nombre d’arbres d’una finca 

4) Permet realitzar mapes temàtics que ajudin a conèixer el territori. 

 

També permeten fer les operacions habituals dels altres sistemes d’informació: 

5) Estructurar la informació en camps dins de taules que poden vincular-se (base de 

dades relacional). 

6) Generar llistats de sortida. 

2.2.2 REQUERIMENTS DE FUNCIONAMENT DEL SIG 

La implantació d’un SIG també necessita d’una sèrie de requeriments per a realitzar-se 

amb èxit: 

a) La organització d'aquestes dades s'ha d’emmotllar a unes estructures prèviament 

definides. Cal tenir especial cura en definir correctament aquestes estructures, 

doncs és difícil canviar-les amb posterioritat.  

Exemple: Per motius fiscals ens adonem que necessitem distingir si el propietari 

d'una finca era empresa, particular o institució; si no ho hem previst prèviament 

no tindrem cap camp on posar-ho, i encara que l'afegim amb posterioritat, tota 

la informació prèvia al canvi no disposarà d'aquesta informació. 

b) És important distingir quines dades són importants i quines ho són menys. Un 

sistema d'informació excessivament complex és menys eficient i dificulta la seva 

utilització. 

Exemple: Es pot decidir estructurar la informació segons àrees de coneixement 

(comptabilitat, planejament, registre) de manera que cada departament s'ocupi 

de mantenir les dades corresponents. 

c) La informació de partida ha de ser fidel a la realitat, homogènia i sense 

ambigüitat. De vegades la implantació d'un Sistema d'Informació Geogràfica 

posa de manifest inexactituds i incoherències en les dades que es desconeixien 

prèviament. 
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Exemple: S'han d'identificar els possibles errors o omissions en les dades que es 

carreguen inicialment en el sistema. La informació s'ha de polir i depurar segons 

uns criteris preestablerts definits per uns protocols. 

d)  La informació ha d'estar actualitzada. La informació no actualitzada és pitjor que 

la manca d'informació. 

Exemple: Hi ha d'haver la possibilitat de fer modificacions, altes i baixes. 

e) Els continguts s'han de poder consultar. Cada usuari té unes necessitats diferents 

per a la consulta de dades. 

Exemple: És molt diferent consultar la cartografia en un visualitzador per un 

usuari no especialista que explotar aquesta informació per a fer estudis 

territorials complexos (incorporació de dades poblacionals, xarxes 

d’infraestructures, projeccions de necessitats futures, topografia...) 

2.3 EXPERIÈNCIES SIMILARS 

Des del punt de vista del sistema d’informació més general, com a catàleg i seguiment 

del patrimoni trobem punts en comú amb: 

- La disciplina de la comptabilitat, que ha estat de vegades definida com a “ciència 

del patrimoni”, estudia la dinàmica de la evolució del patrimoni, encara que no 

exclusivament immobiliari. 

- També trobem punts de contacte amb el control d’estocs que es fa a la industria 

i a la logística per a seguir l’inventari de productes d’un magatzem. 

En un context més proper podem trobar les experiències següents: 

- Cadastre de Rústica i d’Urbana (Ministeri d’Hisenda). 

- Registre de Planejament Urbanístic de Catalunya (RPUC) del Departament de 

Política Territorial i Obres Públiques (DPTOP) de la Generalitat de Catalunya. 

- Inventari de Vedats de Caça que ha realitzat recentment el Departament de Medi 

Ambient i Habitatge de la Generalitat de Catalunya (DMAH). 

Aquests enfocaments són relativament estàtics donat que la seva intenció és 

bàsicament inventariar i classificar; la aportació de la metodologia que aquí es planteja 

és doble: Per una banda plantejar un seguiment històric de la evolució del patrimoni 

(seguint un enfocament contable) i per l’altra incorporar criteris i metodologia per 

relacionar patrimoni de sòl i planejament. 
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3 TREBALLS REALITZATS 

3.1 TREBALLS PREVIS 

En primer lloc es va procedir a examinar la massiva quantitat d’informació 

proporcionada. 

Es va constatar que l’únic vincle que existeix entre la informació alfanumèrica amb la 

que es treballa actualment i la informació cartogràfica de la que es disposa és un 

identificador. 

El departament de patrimoni ens va aclarir que aquest identificador s’anomena OBI 

(Obtenció de Béns Immobles) i s’assigna per a cada adquisició en funció del propietari 

del que s’obté. 

En la base de dades patrimonial aquest codi OBI es vincula amb un o més codis CAT 

que corresponen al catàleg de béns, que tenen una escala més granular però que 

malauradament no tenen definició gràfica. 

Aquest nivell informació es correspon amb la informació registral del es finques, que 

no correspon necessariament amb el Cadastral. 

Una altra particularitat del  la manera de gestionar el patrimoni que té INCASOL és que 

tota entitat patrimonial ha de formar part necessàriament d’una Actuació, a la qual li 

correspon un codi anomenat AMA (Arxiu Mestre d’Actuacions). 

3.1.1 ESTUDI DE LA INFORMACIÓ DE BASE 

La documentació proporcionada per INCASOL va ser la següent: 

- Aixecaments topogràfics en CAD de les propietats que pertanyen a les diferents 

actuacions. 

- Plànols en paper de les diferents actuacions. 

- Arxiu DGN amb la informació de planejament de la que disposa INCASOL. 

- Captures de pantalla del programa de gestió patrimonial actualment en 

funcionament, que treballa únicament amb informació alfanumèrica. 

- Llistats en paper de la informació de planejament de la que disposa INCASOL. 

- Llistats en paper amb informació de compravenda de cada actuació. 
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- Fitxes cadastrals en format PDF extretes de la web del Cadastre (informació 

protegida). 

També es van tenir algunes reunions amb els futurs usuaris per a poder conèixer la 

metodologia de treball de INCASOL i poder adaptar el sistema a les necessitats i a la 

manera de treballar de la institució. 

3.1.2 ENTREVISTES AMB ELS RESPONSABLES 

Addicionalment, durant les tasques d’elaboració del Sistema es va incorporar una sèrie 

de funcionalitats addicionals fruit de les converses amb el responsables d’INCASOL: 

- Permetre el seguiment en el temps de la evolució del patrimoni. 

- Incorporar la informació de planejament i realitzar càlculs del potencial 

urbanístic de les entitats patrimonials. 

- Crear una eina preparada per a créixer en el futur i per a incorporar noves 

tecnologies a mesura que aquestes siguin disponibles. 

3.1.3 PLATAFORMA DE TECNOLÒGICA ESCOLLIDA 

S’ha optat per una “geodatabase” basada en Microsoft SQL Server a través d’una 

connexió amb tecnologia ArcSDE i basada en estàndards oberts (XML). 

En el futur es pot migrar aquesta base de dades a altres solucions DBMS de robustesa 

industrial com DB2, Informix, Oracle o PostgreSQL. 

Aquesta solució permet mantenir un registre històric de totes les modificacions a 

través d’un registre de versions mitjançant unes taules delta (d’altes i baixes). 

Algunes de les avantatges que ofereix el sistema son: 

- Robustesa i escalabilitat 

- Capacitat d’ús concurrent multiusuari (granular) 

- Possibilitat de migració (basat en XML) 

- Possibilitat de funcionament amb Delta tables: Versioning (long transactions) i 

Històric (short transactions) 
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3.2 PREPARACIÓ 

Es va importar la cartografia d’un total de quinze actuacions, les quals es detallen a 

continuació amb el seu codi assignat per INCASOL: 

 NOM CODI AMA 

01 SANT VICENÇ DE CASTELLET (CAN CASES) [1796] 

02 L’ALDEA (ESTACIÓ DE MERCADERIES) [0376] 

03 AMPOSTA (EIXAMPLE LES TOSSES) [0213/0214/0993] 

04 ALGUAIRE (TORRE DEL TABAC) [1342-2] 

05 SANT JOAN DE LES ABADESSES (COLONIA LLAUDET) [1415] 

06 CASTELLGALÍ (EL PLA DEL CAMÍ) [0195] 

07 ESPARRAGUERA (COLONIA SEDO) [1814] 

08 ARBOLÍ + ALFORJA + LA FEBRÓ + VILAPLANA (MAS D’EN BLAI) [1853] 

09 AIGUAVIVA + RIUDELLOTS DE LA SELVA (ENTORN AEROPORT – CAN VINYOLES) [2213] 

10 SANTA COLOMA DE CERVELLÓ + SANT BOI DE LLOBREGAT (COLÒNIA GÜELL) [0922] 

11 BARCELONA (AVINGUDA NOU DE A RAMBLA) [?] 

12 BADALONA (BARRI SANT ROC, BLOC E) [?] 

13 MORA LA NOVA (SECTOR 10) [1632] 

14 TORTOSA (EL PARC DE LA FIRA) [0259] 

15 LA SÈNIA (CARRETERA DE LA GALERA) [1214] 

3.2.1 IMPORTACIÓ DE LA BASE CARTOGRÀFICA 

La cartografia en format DGN s’ha importat al programa ArcGIS mitjançant la eina 

Conversion Tools > To Geodatabase > Import from CAD. 

El resultat d’aquesta informació és una geodatabase que conté: 

- Les entitats gràfiques separades en feature datasets segons si son polígons 

(trames, polilínes tancades, circumferències), línies (línies, arcs, polilínes obertes) 

o punts (punts, textos). Addicionalment també s’importa un feature dataset que 

s’anomena CadDoc i que es correspon amb l’extensió del document CAD. 

- També s’importen unes taules que es corresponen a la informació no geomètrica 

extreta del CAD (capes, colors, tipus de línia...) 
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Es vinculen les taules alfanumèriques a les entitats gràfiques mitjançant l’identificador 

únic EntID i es seleccionen les que es volen importar per els seus atributs (per exemple 

les de color vermell de la capa sectors). 

Durant el procés d’importació es georeferencia la informació provinent del CAD, en 

aquest cas utilitzant la referència espaial European Datum 1950 UTM Zone 31N donat 

que totes les propietats son a Catalunya. 

3.2.2 DEPURACIÓ DE LA CARTOGRAFIA IMPORTADA 

Un cop realitzada la importació de cada arxiu, cal executar l’ordre Data Management 

Tools > Features > Check Geometry; en el cas que es trobi algun error caldrà executar 

Data Management Tools > Features > Repair Geometry per a corregir-lo i evitar tenir 

geometries no vàlides que poden generar errors, la més comuna de les quals és 

incorrect ring ordering, que es produeix quan s’importen polígons els nodes dels quals 

estan numerats en ordre invers, cosa que confon al programa pensant que són forats i 

els assigna una area negativa. 

A continuació cal comprovar que no hi hagi superposicions en la geometria importada, 

que poden ser conseqüència d’entitats coincidents en l’arxiu de CAD o d’errors en la 

rutina d’importació. 

Per a fer això, procedim a crear una nova Feature Dataset amb ArcCatalog i hi copiem 

les entitats importades. A continuació es crea una topologia amb l’ordre File > New > 

Topology i es tria que la regla que s’ha de complir sigui Must Not Overlap, és a dir, que 

no hi hagi superposicions. 

Si carreguem aquesta topologia a ArcMap se’ns mostraran els errors en vermell i si 

anem a Layer Properties > Errors podem generar un llistat dels errors trobats. 

Si es troba algun error caldrà que el depurem manualment la cartografia, essent 

necessari en algunes ocasions netejar l’arxiu de CAD i reimportar de nou les entitats 

seguint tot el procés. 

És especialment important evitar duplicitats de subsectors, sectors i polígons, agafant 

sempre la entitat més petita de la que es disposi informació. 

A continuació passarem a assignar manualment atributs a les entitats importades, 

essent el més importat el codi OBI que és el que ens vincularà amb la base de dades 

existent. De vegades el codi no apareix en els plànols i ens haurem de guiar per les 

superfícies que apareixen als llistats. 
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Un cop assignat el codi OBI, degut a que aquest pot representar propietats 

discontigües, caldrà executar l’ordre Data Management Tools > Generalization > 

Dissolve fent servir el camp del codi OBI per a poder tenir totes les entitats amb el 

mateix codi OBI com a una única entitat multipart i per tant que participin en els 

càlculs que facin servir l’àrea de manera conjunta. 

3.2.3 INCORPORACIÓ DE DADES ALFANUMÈRIQUES 

Un cop incorporada la base cartogràfica es va procedir a generar la estructura de 

dades. Per a aconseguir consolidar la informació es van prendre les següents 

precaucions: 

- Definir els camps i determinar indicacions o protocols per a  assignar-los el 

contingut. 

- Creació de dominis per evitar errors tipogràfics i garantir la integritat de la 

informació. 

- Creació de subtipus per a distingir elements diferents dins d’una Feature 

Dataset. 

3.2.4 VINCULACIÓ DE DADES 

La vinculació de dades amb la taula alfanumèrica que conté les dades registrals es fa 

mitjançant el camp que conté el codi OBI. 

Es crea una relationship class en la geodatabase. 

- Nom del vincle: CATenOBI 

- Tipus: Simple 

- Cardinalitat: 1 a Molts 

- Notificació: Deshabilitada 

- Taula origen: TAULA_CAT (del sistema actual de INCASOL) 

- Taula destinació: FINQUES 

- Clau taula origen (primary key): ID 

- Clau taula destinació (foreign key): CODI_OBI 

- Forward label: està contingut 

- Backward label: conté a 
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3.2.5 ADDICIÓ DE CARTOGRAFIA ADDICIONAL 

S’ha incorporat la següent cartografia: 

Del Departament de Medi Ambient i Habitatge de la Generalitat de Catalunya: 

- PEINs 

- Vedats de cacera (dades provisionals) 

Servidors WMS 

- Institut Cartogràfic de Catalunya (http://shagrat.icc.es/lizardtech/iserv/ows?) 

- Cadastre  (http://ovc.catastro.meh.es/cartografia/wms/servidorwms.aspx?) 

- Planejament municipal (quan esta disponible) 

Elaboració pròpia: 

- Plànol de pendents que cobreix tot el territori de Catalunya 
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3.3 PERSONALITZACIÓ 

Finalment, s’ha personalitzat el programa ArcGIS per tal de facilitar el funcionament de 

l’aplicació: 

- Es tria un esquema de colors per a cada entitat 

- Es retola cada entitat codificant amb el color i les dimensions de la font les 

diferents característiques així com ajustant la visibilitat en funció del nivell de 

zoom. 

- S’agrupa la informació semblant en la llegenda. 

- Es creen uns bookmarks per a cada actuació per a poder-les localitzar fàcilment. 

- S’han programat les funcions repetitives amb Model Builder. 

- S’incorpora funcionalitat addicional d’exportació. 

- Es generen unes sortides amb l’ajuda de Crystal Reports. 

 
Figura 2: Exemple de pantalla 
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4 BIBLIOGRAFIA 

4.1 LEGISLACIÓ 

Text refós de la llei d’urbanisme 

Decret legislatiu 1/2005, de 26 de juliol, pel qual s’aprova el text refós de la llei 

d’urbanisme 

 

Reglament de la llei d’urbanisme 

Decret 305/2006, de 18 de juliol, pel qual s’aprova el reglament de la llei d’urbanisme 

 

Llei de sòl 

Llei 8/2007, de 8 de maig, de sòl 

 

Mesures urgents en matèria urbanística 

Decret-llei 1/2007, de 16 d’octubre, de mesures urgents en matèria urbanística 

 

Llei del dret a l’habitatge 

Llei 18/2007, de 28 de desembre, del dret a l’habitatge 

4.2 WEB 

Sistematització de documents de planejament 

http://www.coac.net/sistplan/ 

 

Referències cadastrals 

http://www.catastro.meh.es/esp/referencia_catastral1.asp 


